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1
Welcome to WinDelete

WinDelete is the safest, easiest way to uninstall software in Windows� and Windows
95�. WinDelete�s powerful features help you optimize your computer�s performance by
managing software applications, removing unnecessary file information, and recovering
valuable disk space.

Anyone who installs Windows-based software knows how difficult it can be to keep track
of all the files and directories placed on your computer�s hard drive. Finding and deleting
this information once the program is no longer needed is an even more frustrating task.
WinDelete takes care of this for you by memorizing all the items you install so when you
delete a software program, it knows exactly which files to remove and where they are
located. If you chose to have WinDelete make a backup copy of the files being erased,
those files can be decompressed and reinstalled utilizing the Undo Last Uninstall com-
mand (see Chapter 4, Using WinDelete Uninstall).

Unlike any other program of its type, WinDelete not only memorizes file attributes and
paths (location) but actually reads the content to insure only unnecessary information is
deleted. This is why WinDelete is the safest, most comprehensive uninstall utility on the
market. With all of these features everyone can benefit by using WinDelete. What could be
easier!

Introduction to WinDelete
First-time users of WinDelete will benefit from reading all parts of this manual. Each
chapter discusses a different WinDelete attribute, giving detailed explanations of its
purpose and operation.

WinDelete has eight main components which can be accessed through the toolbar, menu
bar, Quick Reference Card (main screen) or keyboard. The task you want to perform
determines which button you use:

Install: Install an application through WinDelete
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Uninstall: Remove an application from your hard disk

Duplicate Finder: Find and remove duplicate files

System Editor: View, modify or print system files

System Tuner: Fine tune your computer system

Graph Viewer: Display a graph of system disk usage

Log Viewer: Display a WinDelete log file

System Consultant: Display and explain your computer system

Typographical Conventions
In this manual the following conventions are used:

� Keyboard keys are printed in boldface and enclosed by <brackets>, such as: <Enter>,
<Tab>, or <F1>.

� Button names appear in boldface.
� Pull-down menu instructions are printed as: menu name | option. For example, the

instruction �Pull down the File menu and choose Install� appears as File | Install.
� Key combinations are displayed in <angle brackets> and joined by a plus sign. For

example, <Alt + A> means �Hold down the <Alt> key and press the letter <A>.�
� Bold italics indicate new terms.

Installing WinDelete

System Requirements
The following hardware and software configuration is recommended for running
WinDelete:

� At least a 386 compatible PC or better
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� 4MB of RAM
� 3MB of free hard disk space
� Windows 3.1 or later
� VGA graphics or better

Before You Begin
Make sure you complete and send in your registration card. As a registered user you�ll be
informed of product updates and upgrades, as well as new product releases. If you
purchased WinDelete directly from IMSI, you are preregistered.

Installation
To install WinDelete, you must use the Install program included on the program disk. The
files are compressed and cannot simply be copied to your hard disk.

1. Place Disk #1 in your disk drive.

2. From the Windows Program Manager choose File | Run. If you are using Windows
95, choose Start | Run

3. Enter �A:\Setup� (insert the letter that represents your disk drive) and press <Enter>.

4. Follow the directions on the screen.

Note: The default installation directory is C:\IMSI\WINDEL2. If you want the program installed in
another directory, change the directory name.

Getting Help
When you have a question, you can refer to this manual or use WinDelete�s quick and
convenient on-line Help system. Click the Help button on the toolbar, or press <F1> to
access the help index. For more information on using the Help system, see WinDelete�s On-
Line Help System in Chapter 2.

If any information or features are added to WinDelete after this manual is printed, it will
be included in a README.TXT file on your original disk.

Technical Support
If you can�t find the answer to your question either in this manual or through the Help
system, our Technical Support staff is here to help you. Following is a list of the informa-
tion you should have handy when you call our Technical Support staff. If you have a
question about how something in WinDelete works, you need know only the first three
items. If you are having a hardware or system problem, please try to have all the informa-
tion available when you call:

� Your name, address, and phone number
� The product name and version number (Choose Help | About WinDelete)
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� Your computer make and model
� The DOS and Windows versions currently installed
� Amount of RAM and type of extra memory manager
� Contents of a CHKDSK (type CHKDSK at the C:\ prompt)
� Graphics adapter and monitor type
� Printer or plotter make and model
� Contents of your CONFIG.SYS and AUTOEXEC.BAT files
� The text of the error message and a concise and clear description of the problem

The telephone numbers and addresses for IMSI are on the front page of this manual.
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WinDelete Quick Tour

This chapter introduces you to the basic information about WinDelete: how to start, exit,
and find your way around the program.

Starting WinDelete
To start WinDelete, open the IMSI group icon located in the Windows Program Manager. Double-
click the WinDelete icon and the WinDelete main screen (Quick Reference Card) appears.

Exiting WinDelete
To exit WinDelete, click the Exit button on the toolbar, or choose Action | Exit.

Note: If you have a sound card installed on your computer, WinDelete 2.0 can play .WAV files
while starting or exiting the program. To enable this feature, copy the desired .WAV files into the
WinDelete directory and rename them WDSTART.WAV and WDFIINISH.WAV.

Opening Screen
The WinDelete main screen contains a menu bar, a ten-button  toolbar, a status bar, and
the Quick Reference Card. To access any option, click the appropriate button on the
toolbar, select an option from the menu bar, or click a Quick Reference Card button.

Menu Bar
The Menu bar gives you access to WinDelete�s pull-down menus. To display a pull-down
menu, click on the menu name or press <Alt> plus the underlined letter in the menu
name.  Hot keys are available for most menu commands. The following menus are available:

� Action
� Tools
� View
� Help
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Action Menu
The Action menu enables you to:

� Begin the Install or Uninstall process
� Scan your computer for duplicate files
� Undo the last Uninstall
� Configure your printer
� Exit WinDelete

Tools Menu
The Tools menu gives you these options:

� Examine a log file of all WinDelete activities performed on your computer
� View a graphical representation of your computer�s hard disk usage
� Optimize your system�s performance
� View, edit and print important system files
� Display information about your computer�s software and hardware configuration

View Menu
This menu allows you to customize WinDelete by displaying or hiding the Toolbar and
Status bar.

Help Menu
You can get additional information about any topic by choosing Help | Help on
WinDelete from this  menu. While in the Help system, you can scan through the Index,
Search for a specific term or topic, and print the information you need. To see what version
of WinDelete you are currently using, choose Help | About WinDelete from the menu bar.

Toolbar
The WinDelete Toolbar contains ten buttons. From the toolbar you can install and
uninstall software, search for duplicate files, edit system files, fine-tune your system�s
performance, view a graph of  file statistics, view and print a log file, review system
configuration, get help, or exit the program.

Note: Holding the cursor over a toolbar button will display the tool name.

Status Bar
The Status bar is located at the bottom of the screen and gives you a brief explanation of
the task being performed, or prompts you when the program is ready to operate.
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Quick Reference Card
When you start WinDelete, an animated menu is displayed on the desktop (the space
between the toolbar and the status bar). This area is called the Quick Reference Card, and
its moving graphics are actually buttons that you can click to launch any of WinDelete�s
utilities!  When no tasks are being performed, the Quick Reference Card occupies the
desktop.

Utility Workspace
The Utility Workspace replaces the desktop when you access any of WinDelete�s utilities.

Note: In general, when you are working in each utility, the procedure you will follow flows
intuitively from left to right. You begin by selecting an item in the box on the left, then you move to
the box(es) on the right, and finally, you select a function button (Uninstall, Save, Close, etc.).

Color Coding System
WinDelete provides a unique color-coding system to help you determine which files can
safely be removed from your computer system. Uninstall analyzes all the files and assigns
a color to each one. The color-coding standards are as follows:

Green
Files installed through WinDelete or those that meet the safety criteria. These files can be
SAFELY removed.



2 - 4

WinDelete 2.0

Yellow
Files NOT installed using WinDelete or files that do not meet the safety criteria. Look
carefully at each file BEFORE selecting it for removal.

Application List Box
This is the window found on the left side of the Utility Workspace. Depending on which
utility you�re using, the Application List Box will display a list of program groups, file
types, installs and uninstalls, or  system components.

List Items
One of  three important symbols will appear to the left side of each list item: a plus sign
(+), a minus sign  (-), or a blank box (o). Clicking the plus symbol expands the list one
level and places a minus sign in place of the plus. Single-click the minus sign to collapse
the list. When you do this the plus symbol reappears. The blank box (o) appears next to
individual files. If none of these symbols appear, the data listed is for informational
purposes only.

Tab Dialog Boxes
Two Tab Dialog Boxes are located on the right side of the Utility Workspace. Each tab can
be clicked to reveal detailed file information, instructions, or useful tips. Lists displayed in
these may be expanded or collapsed by clicking the plus and minus symbols.

Function Buttons
On the far right-hand side of the Workspace you will see some large buttons. These
represent different functions in each utility. The bottom button will always be Close or
Cancel and may be clicked to return you to WinDelete�s main screen.

WinDelete�s On-Line Help System
The quickest way to get an answer to any question you have is to use the on-line Help
system. With WinDelete�s convenient support, Help is on its way!

Using On-Line Help
There are many ways you can access the on-line Help system. The quickest way to get help
is to press <F1> from anywhere within the WinDelete program. This will bring up the
Help Index. You may also click the Help button or select Help | Help on WinDelete from
the menu bar.

Note: For detailed instructions on searching for and printing Help topics, consult your Windows
User Manual.



3
Using  WinDelete  Install

Why use WinDelete instead of the Windows Program Manager when installing new
Windows software? The answer is  simple. WinDelete records all stages of the installation
process and knows exactly where the files are placed and what changes were made to your
system . The Program Manager does not. When you want to uninstall a software program,
it can be removed safely and completely. When using File | Run  in the Windows Program
Manager or Start | Run  in the Windows 95 shell, choose� install with WinDelete� in the
dialog  box. It�s that easy!

  How Install Works

Before installing any software, WinDelete reads and analyzes the contents of your hard
drive. First, WinDelete takes an initial �snapshot� of your current system configuration
and files. After the software is installed, a final snapshot is taken of the updated system and
compared to the initial snapshot. Finally, a dialog box appears letting you know the
installation was successfully monitored, and gives you the opportunity to personalize the
name of the installation log. Initially, the Log Title box defaults to the program name. If
the application you installed did not create an icon or a program group,  a time/date stamp
will appear in the Log Title box. In either case,  you may delete the text and type in any
title you want. When you are finished, click the OK button to return to the main screen.

Using Install
You can access the Install mode wether or not WinDelete is currently  running. You can
operate the Install feature through Program Manager�s File | Run  menu , 95 shell�s  Start |
Run menu, or  through WinDelete�s active desktop.

Procedure
To access Install through Program Manager:

Choose File | Run from Program Manager�s menu bar. When the Run dialog box appears
enter the software�s installation program name and location (e.g., A:\INSTALL) on the
command line and select the option to install with WinDelete. When ready, click OK.
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To access Install through Windows 95 shell:
Choose Start | Run. When the Run dialog box appears enter the sofware�s installation
program  name and location (e.g. A:\INSTALL)  on the command line. Select the option to
install with WinDelete. When ready, click OK

To access Install through WinDelete:
There are three ways. Click the Install button on  the toolbar or the Quick Reference
Card, or choose Action | Install from the menu bar. Follow the instructions on the screen.
When installation is complete, WinDelete will notify you and ask if you want to name the
install for reference in the Log Viewer.

The Workspace
Application List Box

WinDelete performs a series of system checks on various aspects of your computer system
during the installation process. The list includes:

� Program Groups
� Application Icons
� File Structure
� Windows Registry Files
� System Files

Tab Dialog Boxes
The progress of the system checks is reported in the Status area in the upper Tab Dialog
box. Here the Initial, Final, and Compare phase of each system check is marked off as it�s
completed by WinDelete.

Initial Phase
WinDelete takes a �snapshot� of your current system configuration before adding the new
program. After completing this, the WinDelete Program window disappears (minimizes)
and the application�s installation procedure begins.

Final Phase
When the new program�s installation procedure finishes, WinDelete takes another
�snapshot� of your system configuration including the new software program.

Compare Phase
A comparison of the before and after �snapshots� is performed and the information is
stored in the WinDelete database.

After WinDelete completes the Final phase of installation, a dialog box will appear telling
you that WinDelete  successfully monitored the installation.  It will also give you the
opportunity to personalize the installation. The Log Title edit box contains default text,
but you can delete  this  and enter any  name for the installation log file. The information
you enter  in this box will be used to label the log entry in the Log Viewer.
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Function Buttons
Cancel
Cancel the operation and exit the utility.

Points of Interest
WinDelete launches the installation program included with your software application. If
an error occurs during the installation procedure, contact the software developer or refer
to the software manual.

Never install new software programs in the Root (C:\), DOS, or Windows directory unless
you are required or directed to do so. These directories contain software and information
your computer needs to run efficiently. Placing extraneous programs here may slow down
your computer and hamper the removal of software programs when you no longer need
them.

Behind the Scenes

Before It  Installs, WinDelete...
� searches and analyzes the file structure of your hard drive.
� reads and records the contents of the Windows and Windows\System directories.
� reads and records the content and  location of all Program Groups, registry files, and

system files.

No Program Group or Icon
Certain software applications do not create their own program groups or program icons.
When this happens, the Log Title box (in the post-installation dialog box) will automati-
cally display a time/date stamp. You may either click OK to accept this default, or replace
it with text of your own. You need to be able to identify the program by this description
when viewing files in Uninstall mode. When you�re ready, click the OK button to return to
the Installation screen.

Note: When installing a DOS application or software that doesn�t automatically create an icon in
Program Manager, WinDelete will create an internal icon for its own reference. This icon is created
for uninstalling purposes only, and will be stored in the WinDelete Installations program group -
visible in the Uninstall mode. The icon will not appear in the Program Manager. If you wish to
create an executable program icon, consult your Windows manual for instructions.

Windows Restart or Reboot
WinDelete is designed to recognize that a restart has occurred during application installa-
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tion and will automatically restore itself upon reentering Windows. There are some
instances where WinDelete will not automatically resume operation upon entering
Windows. In this case, simply double-click on the WinDelete icon and WinDelete will
recognize that an installation was in progress and ask you if you would like to continue.

Trouble Shooting
WinDelete Install classifies errors into two categories: application errors and WinDelete
errors:

� Application errors are errors that occur after WinDelete relinquishes control of the
installation and the software�s installation instructions take over. If you experience an
application error, contact the software developer of that application, or refer to the
application�s software manual.

� WinDelete errors are errors that occur before the software installation begins or after
the successful installation of the software program. WinDelete install errors are rare,
but if a WinDelete error occurs, consult the on-line Help System. If the answer still
cannot be found, contact IMSI Technical Support.

If you are having difficulties installing an application through WinDelete, verify that the
program will properly install through the Windows File Manager.

Note: If the WinDelete window does not reappear after installing an application, exit Windows and
then reenter. The WinDelete window will reappear.
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WinDelete Uninstall safely and thoroughly removes unwanted software applications from
your hard drive. Uninstall removes program groups, icons, directories and files for any
application you select. WinDelete�s unique color-coding system helps you easily identify
files that can be safely deleted. And if you change your mind after deleting a program, you
can easily restore it.

Because even the most experienced user is bound to make mistakes, WinDelete can store a
compressed backup version of the last application uninstalled. If you decide that you can�t
live without your old application, WinDelete will restore your system to its previous
status. Every file, directory, document, and icon you chose to back up is replaced, bit,
byte, and meg!

Whenever you remove files from your computer you should proceed with caution. A
careless mistake  could be costly.  However,  WinDelete�s  built-in safety  features  will
alert you to  potential dangers.

WinDelete utilizes rigorous safety criteria that protect the beginning user from catastro-
phe while still offering the experienced user control over the system. But regardless of
experience, caution should be used when manipulating your system. If an operation is
considered unsafe, WinDelete will either advise against the action, or deny user access. A
good rule to go by is: If you�re not sure, don�t do it! Ultimately, the decision is yours.

  How Uninstall Works

You may be wondering how Uninstall knows what files to remove and where they are
located. The answer is simple. When uninstalling software installed through WinDelete,
reference is made to all those �snapshots� WinDelete took of your system when it installed
the application (see chapter 3, Using WinDelete Install ). These snapshots act as maps that
tell WinDelete the exact location of all items associated with a particular program. During
the uninstallation process WinDelete makes a copy of all important system files (and every
other file you selected, providing you chose the �Back Up All Files� option in the Uninstall
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dialog box) and removes only the chosen files.

WinDelete classifies software into two categories:

� Software Installed Using WinDelete: If you used WinDelete to install an
application, all traces of that application can be removed. You control the process by
selecting the individual files you want to delete.

� Software Not Installed Using WinDelete: If you want to remove an application that
you installed without  Windelete, Uninstall advise s you as to which files are safe to
remove and which files require caution.  Remember that you  have file-by-file control
over what information stays or goes.

And remember: WinDelete is your friend, and like all good friends it will grant you a second
chance if you ever mess up!

Using Uninstall
Uninstall offers three modes of operation  to aid you in  safe and easy file removal: Trial
Run, Express, or Uninstall. These features will be explained in this  section.

The Workspace
Application List Box

As soon as you enter Uninstall mode, WinDelete scans all program groups on your hard
disk and lists them in the Application List box. This list may be expanded to reveal the
programs contained in each Program Group. Click on a group�s plus sign (+) to view the
program icons it contains, or double-click on the group icon. When you select an applica-
tion, WinDelete displays its associated files in the tab dialog boxes to the right.

Note: Applications that didn�t provide a program group or application icon during WinDelete Install
are contained in the WinDelete Installations group.

Tab Dialog Boxes

The upper box includes only items that WinDelete has determined are safe to remove
(green items) while the lower box includes only items which should be given special
consideration before removal (yellow items).

One or more of the following headings  and items  are displayed in the top portion of the
list box and are safe to delete:

� Application Icon �        Programs
� Primary Application �        Documents
� Related Files �        WIN.INI

Open a folder by clicking on its plus symbol, and then select the files to remove by
clicking on each file name. Unselect a file by holding down the <Ctrl> key and clicking
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the selection. Select multiple items by holding down the <Shift> and clicking on each item
or by dragging the cursor down the list.

Select an Uninstall method, either Trial Run, Express or Uninstall (these are explained
in the section, Function Buttons).

A confirmation dialog box appears.

There are two options that allow you to control how the files are removed. In Express
mode, you can click on the �Make compressed backup� check box. In standard Uninstall
mode, you can click on the �Make compressed backup� check box and/or the �Confirm on
each delete� check box.  If you want to confirm the removal of each file, click the �Con-
firm on Each Delete� box. To make a compressed backup of all files being deleted, click
the �Make compressed backup� box. These options will be described in more detail later.

After choosing your uninstall options, click the Remove button to begin removing files.

Note: Items that appear in the list boxes can be displayed in one of three ways: Filename,
Location, and Details. Select the option that provides you with the most useful information for
your uninstalling needs.

Function Buttons

Trial Run
This option allows you to see how much space will be restored to your hard disk after
deleting an application using Express versus using standard Uninstall. Trial Run does not
remove any files, it merely provides you with a useful estimate.

Note: You must highlight the file(s) you want to uninstall before selecting Trial Run in order to
see the savings using the Express option versus the Uninstall option.

Express
WinDelete provides an express method for deleting applications. This method deletes all
green items displayed in the upper box - and only the green items. This method will easily
and completely remove software installed using WinDelete.

Once you remove an application using the Express method, you may be unable to remove
items which were previously displayed in the lower (yellow) list box. For applications
installed using WinDelete, these yellow items are typically data or document files created
by the program. For other applications, the contents of the lower list box will vary. To
remove these items, you must use the standard Uninstall procedure described below.

Uninstall
This is the most complete method of removing an application. You may use this process
whether or not you installed the application through WinDelete. Uninstall will list files
safe to delete in the upper list box, and those requiring caution in the lower box. Select the
items you wish to remove, then proceed.

Each individual item to be removed must be selected in order to be removed. Folders
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displayed with a plus (+) sign contain items which will only be removed if individually
selected. Click on the folder�s plus sign (+), and select each individual item in the green
and the yellow tab boxes simultaneously.

Use the <Shift> and <Ctrl> keys to select multiple items. If no files are selected for
removal, the Uninstall function button will be unavailable.

Note: It is suggested that you always choose to back up the files being removed. WinDelete will
do this for you�just click the �Make compressed backup� check box when the Uninstall dialog box
appears. Taking this safety precaution will ensure that your files are available for reinstallation
should you suddenly change your mind. This option is explained in the next section.

Close
Close the Uninstall utility and return to the main screen.

Behind the Scenes
WinDelete offers safeguards to protect you from accidentally erasing important files and
gives you the option of reversing your uninstall.

Backup and Undo Last Uninstall Options
In order to insure that a program is available for reinstallation, be sure to choose the
appropriate Backup option.

Backup Options
Make Compressed Backup
When checked, this tells WinDelete to make a compressed copy of each file you choose to
delete. During backup, you�ll see a status gauge that indicates WinDelete�s progress.

Confirm On Each Delete
When checked, WinDelete will ask you for confirmation before a file is deleted.

The Undo Last Uninstall Option
Choose this option if you mistakenly uninstalled any files, or if you want to reinstall the
last program uninstalled. This option is available only if you chose to backup the files
before uninstallation. To access the Undo Last Uninstall function, Close the Uninstall
utility and choose Action | Undo Last Uninstall from the menu bar. You will see a dialog
box informing you that WinDelete is about to restore a backup. Confirm this action to
proceed. The files being restored will be placed in the same location from which they were
uninstalled.

Trouble Shooting
You should not delete the contents of any WinDelete program subdirectories or attempt to
modify them in any way. These files store information and history on installs and
uninstalls performed through WinDelete as well as any backups it might have made.

If you have removed an application that created an icon in the Startup Group, you will get
an error message upon entering Windows. Select the icon in the Startup Group, and press
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the <Delete> key to correct this error.

If  you choose to remove an application which has an icon in both the Start Up and
primary application group, WinDelete will perform a more thorough job if you uninstall
the item in Start Up first.

When the Confirm Uninstall dialog box appears, you  have  the option to make a com-
pressed backup of the  application or  set of files  you  are removing  from your system.
However,   if you choose this  option, WinDelete will erase any previously backed-up files.

If you�re making a compressed backup of an application or file which you plan to restore
later, select all files in the upper (green) and lower (yellow) tab dialog boxes. The Express
mode only removes the contents of the upper tab dialog box, so there�s no gaurantee  the
application can be restored correctly.
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Your computer�s speed and efficiency is greatly affected by the amount of available hard
disk space and the size of essential system files. You can help your computer utilize
available resources by monitoring the amount of information loaded into memory and
keeping this information organized and up to date.

How the Utilities Work
WinDelete provides specialized utilities to help you organize, optimize and maintain your
computer�s system. These features contribute advice on where disk space can be saved and
provide you with the means to edit system files and delete duplicate items.

To protect the integrity of your system, WinDelete offers to back up all files prior to any
task you perform. Files may be restored if you change your mind. All modifications are
automatically recorded in the Log File which can be viewed and printed for future
reference. You may also create a pie chart showing the breakdown of disk usage, or read
about your computer�s hardware and software configuration. Each utility offers safety,
simplicity and an abundance of valuable information with the click of a button!

  Duplicate Finder

Duplicate Finder uses specific search criteria to help you locate and safely remove the
redundant files that clutter your system and occupy valuable disk space. You can custom-
ize WinDelete�s search by Filename, Filename Date and Size, or Extension.

Important: The default extensions for Duplicate Finder are document files. Advanced users may
customize this list to include any type of extension, including .DLL and .EXE. All users should
exercise caution when searching for and deleting duplicate .DLL and .EXE files. Certain programs,
including Windows, may require particular versions of .EXE and .DLL files to operate correctly.
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The Workspace
Application List Box

This box lists file types to target during duplicate search. WinDelete includes these default
file extensions:

� BMP Bitmap graphics
� DOC Text files written in Microsoft Word
� INI Initialization files (use extreme caution when evaluating these files!)
� PCX Bitmap graphics created in Paintbrush
� TXT Text files created in Windows Notepad
� WRI Text files created in Windows Write

Tab Dialog Boxes
The upper tab box displays a list of all duplicate files, organized by Location (path) and
Details (size and date). Here, you will see a list of all duplicate files found during the
system search. Click on the Location tab to view filenames and the drive and directory
where they are located. Click on the Details tab to see the filename, file size, and date it
was created.

The lower tab box lets you customize your search by adding your own file extensions and
choosing the parameters of your search. There are two tabs in this box: Search For and
Extension.

In the Search For box, you may choose one of the following search options:

• Filename Only: Search for all duplicate files with the same name, regardless of
extension.

� Filename, Date and Size: Search for all files with the same name, extension, size,
date, and time.

� Extension Only: Search for files with the same extension. This feature searches for all
files with a particular extension and lists all files found, including duplicates.

Click the Extensions tab when you�re done choosing your options to create a custom file
extension for your search, or to edit the list or extensions. In the Extensions tab box, you
will see two edit boxes, one scrollable list box, and two buttons. Their functions are as
follows:

• Extension: In the first edit box, enter any file extension you wish Duplicate Finder to
target during its system search. Remember to type in all caps, and omit any
punctuation (e.g.., ICO, BAT). Again, it is suggested that only experienced users use
this  function.

• Description: Next, enter a description of the file extension in the Description edit
box. The extension and its description will appear in the Application List Box exactly
as you type them here.
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• Add: After you�ve entered your file extension and description, click the Add button.
This will add the extension and its description to the list in the Application List Box.

• Remove: Select an extension from the list box and click Remove to erase it from the
Application List Box. Both custom and default extensions will be listed here. You may
remove custom and default extensions to make your own personalized file list which
will appear each time you enter the Duplicate Finder utility.

Function Buttons
Remove
Eliminate the selected duplicate files from your hard disk (you will be given the option to
make backups).

Close
Cancel the operation or exit the utility.

  System Editor

Warning: This is an Advanced Feature. The contents of .INI files are essential to the operation
of all Windows-based programs and should only be modified by advanced users. If you choose to
use this utility, be sure to backup the files being modified before editing.

When you delete a program without WinDelete, program settings, registries and .INI
sections can be left behind in the WIN.INI and Windows system directory.  WinDelete�s
System Editor enables you to edit .INI files and delete these outdated instructions which
are needlessly taking up space on your hard drive. In turn, Windows will operate faster
and more efficiently.

What is an Initialization File?
An Initialization File (abbreviated as .INI) is a list of directions, or settings, that Windows
uses like a map to find and execute Windows-based software programs installed on your
hard drive. .INI files are found either in your Windows and Windows\System directories,
or in the directory of the program it represents.

Since Windows is actually a software program supported by your computer�s Disk
Operating System (DOS) it also needs an .INI file. When you execute Windows, the first
files your computer accesses are WIN.INI and SYSTEM.INI. These files contain important
instructions that enable Windows to set up according to your preferences and your
computer�s hardware configuration.

Just as Windows relies on DOS to operate, all your Windows-based programs rely on
Windows to operate. Usually, an application will maintain its own .INI file in its program
directory, but smaller applications sometimes add their .INI file (in the form of a section
with bracketed heading) to the WIN.INI file. When this happens, the WIN.INI grows,
making the list of instructions to be read by Windows longer. Since this list is read each
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time you start Windows, a longer list means a longer wait for you. Keeping your system�s
.INI files updated will dramatically improve its performance.

How System Editor Works
The System Editor allows you to edit, delete, or add values to Window�s most important
system files: WIN.INI, SYSTEM.INI, CONTROL.INI, DOSAPP.INI,  and WINFILE.INI.
The System Editor workspace allows you to easily translate, navigate and manipulate your
computer�s cryptic system files.

The Workspace
Application List Box

When you first enter the System Editor, you will see a dialog box where you can choose
the file you want to edit. Select the file and click OK. After you open a file, its section
headings will be listed in the Application List Box. Click on a heading�s plus (+) symbol to
view the entries and their values.

Tab Dialog Boxes
The lower box  contains Help and Tips for the System Editor. The upper box contains two
tabs which allow you to edit, delete, or add a value to the chosen system file.

Edit  Item
When you choose a section to edit from the Application List Box, its heading, entry and
value are displayed in the Edit Item tab box. The value will appear in an edit box. Click
Remove to delete this line from the section, or change the value and click Update. If you
accidentally delete something don�t worry � the changes are not final until you click on
the Save function button.

Add Item
This area contains three edit boxes. The first is a drop-down list box where you type a
heading for the section you wish to create. In the second box, insert a section entry. In the
third box, set the entry value. When you finish, click Update to implement your changes,
or Close to escape without saving changes.

Function Buttons
Open
Displays a list of system files available for revision: Select a file and click OK. You may
choose any of the following system files:

� WIN.INI •        DOSAPP.INI

� SYSTEM.INI •        WINFILE.INI

� CONTROL.INI

Print
Print a copy of each edited file.

Save
Accept revisions and replace original file with your updated version. When you click on
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the Save button, a dialog box will appear. You can select  the �Make backup before saving�
check box to save a copy of the original file, and then click Continue. Click the Cancel
button to return to the workspace without saving changes.

  System Tuner

The System Tuner helps you optimize your computer�s efficiency by performing diagnos-
tic checks on all important system files and directories on your computer�s hard disk. It
makes sure that all entries and values in the system files are configured correctly and
notifies you if they are not. System Tuner also advises you on the severity of any problems
and how they might be corrected, if possible. When you click on the System Tuner icon in
the main screen, WinDelete automatically scans your system and sends the results to the
System Tuner workspace. The system scan may take a while, so be patient! The results of
the scan are organized into four categories, represented by icons, and the status of each is
displayed using three colors.

How System Tuner Works
The System Tuner investigates your computer�s hard drive to report on the status of four
important elements:  system integrity, orphan files, backup files, and resources (these
terms will be explained in the following section). After it scans these areas, it analyzes the
information collected and decides whether or not the files are in peak operating condition.
If they are not, the System Tuner will notify you and offer to fix the problem. Sometimes,
there is a problem that WinDelete determines is not safe to modify. If this happens, the
System Tuner will outline the problem but refuse to alter the files involved. The System
Tuner is a very complex utility, so please read this section carefully.

The Workspace
Application List Box

The System Tuner uses the same color-coding system as the rest of the WinDelete pro-
gram:

� Green: Safe. Indicates that this area of your system is operating efficiently.
� Yellow: Caution. Indicates that there is a problem that may be corrected through

WinDelete.
� Gray: Alert. Indicates that there is a problem which cannot be corrected using

WinDelete.
After System Tuner completes its scan, you will see four icons listed in the Application
List Box. Every icon is appointed a color, according to the outcome of the search. Each
icon represents a category, or area, of your computer system. You can click on any icon�s
plus (+) symbol to expand that category and view its subcategories. The categories and
subcategories are as follows:
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Integrity Check
Reads the following four system files and determines the validity of each entry.

• AUTOEXEC.BAT (used by DOS)

• CONFIG.SYS (used by DOS)

� WIN.INI (used by Windows)

� SYSTEM.INI (used by Windows)

� Invalid Icons

Orphan Files
Scans the Windows\System directory and determines if all items are being referenced in
the appropriate initialization file. When scanning for orphan files, System Tuner looks at
these areas:

• Fonts

• Display drivers

• Temporary files

• Group files

• Lost cluster files

Backup Files
 Looks for any backup files left on your system. Backup files are usually just as large as the
original file and take up unnecessary disk space. WinDelete searches for the following
backup files:

• .BAK files

• .OLD  files

• .SYD  files

• .00?  files (files with any numeric extension)

• AUTOEXEC.??? files (files with any extension except .BAT)

• CONFIG.??? files (files with any extension except .SYS)

Resources
Analyzes your system�s configuration and suggests simple ways to speed up performance.
During its scan, System Tuner looks at these areas:

• Swapfile size-in bytes (Windows 95 does not support this  feature)

• Files= in CONFIG.SYS

• Buffers=in CONFIG.SYS

• Number of fonts

You may click on any of the subcategories to view System Tuner�s comments and sugges-
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tions in the lower tab dialog box.

Tab Dialog Boxes
When you click on an icon in the Application List Box, the tab boxes will display informa-
tion pertaining to that category.

If the icon in the Application List Box is yellow, an expandable list will appear in the
upper tab box. Click on the plus (+) symbol to expand this list. The plus symbol will not
appear if there is only one item in the list. If the icon in the Application List Box is green or
gray, a short read-only message will appear in the upper tab box notifying you that this
area is OK, or that it cannot be fixed by WinDelete.

The upper tab box contains the filename, drive and directory of the items in question.
This information is provided so you know the precise location of the files causing prob-
lems. If the item you selected in the application list box is green or gray, the upper tab
dialog box will display read-only search results. For yellow items, you may select a file
item or multiple items (by clicking the left mouse button and dragging down the list) and
then click the Optimize button. A dialog box will appear asking if you are sure you want
to remove the files. At this point you have the option to proceed or cancel.

The lower tab box contains Help and Tips. The Help tab box will display comments
about the search result of a particular category. If you click on an icon that is yellow, the
box explains the problem and System Tuner�s solution. If the selected icon is green or
gray, the box will display read-only search results.

Function Buttons
Optimize
Click to implement System Tuner�s solution. The Optimize function either deletes
problem files or updates system files in order to let your system operate the way it should.
You will always be given the chance to cancel after you press this button. The Optimize
button will be available only if the selected icon in the Application List Box is yellow.

Close
Abort the operation and abandon the task at hand.

  Graph Viewer

The Graph Viewer is a reference tool that displays your system�s file use. This function
reads all the files on your hard disk and then displays a pie chart that shows the following
information (in bytes):

� The amount of hard disk space that contains GREEN files. Green files can be safely
removed.

� The amount of hard disk space that contains YELLOW files. Look closely at yellow
files before removal!

� The amount of hard disk space that is currently used for required system files is
displayed in WHITE.
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To display the statistical pie chart, click the Graph Viewer button. The chart begins to
build as the files are read. Be patient because this process may take a while! You can click
the Cancel button at any time to exit and return to WinDelete�s main screen.

Note: You cannot change or modify the pie chart; it is informational only.

The Workspace
Application List Box

Here you will find a legend describing the elements of the chart and what they symbolize.

Tab Dialog Boxes
The upper box is where the chart will be displayed. The lower box gives you Help and
Tips.

Function Buttons
Cancel
Abort the operation and abandon the task at hand.

Close
Close the Graph Viewer utility and return to the main screen.

  Log Viewer

Every time you alter your system with the Install, Uninstall, or Duplicate Remover
utilities,  a detailed record of each change is automatically documented in the Log File.
Each action is appended to the end of the Log File, and any portion of this comprehensive
report may be printed for your reference.

The Workspace
Application List Box

This box contains three sections: Installs, Uninstalls, and Duplicate File Removals. Each
group may be expanded to view the Log Title, date, and time of individual entries. All
entries are organized by date, most recent first. When you select an entry, its details are
listed in the top dialog box.

Tab Dialog Boxes
When you select an entry from the Application List Box, the upper tab box displays any
items that have been modified by WinDelete. A list divided into one or more of the
following categories will be displayed: Groups, Icons, Directories, Files, Registry Keys,
and any modified .INI files. Depending upon the complexity of the program installed, any
combination of categories will be included in this list. If a plus (+) sign appears next to the
category, you can expand the list to view any changes made to the items inside. Depending
on the section selected in the Application List Box, the expanded list will contain items



5 - 9

   Chapter 5    WinDelete Utilities

which were installed, uninstalled or deleted from your system through WinDelete.

Function Buttons
Print
Select a log entry in the Applications List Box and click Print to send a report of the
modified files to your printer.

Close
Click to exit Log Viewer utility and return to main screen.

  System Consultant

The System Consultant feature provides vital statistics about your computer�s hardware
and software configuration. Before WinDelete, finding this information would have taken
up a lot of time and, for the inexperienced PC user, was nearly impossible. System
Consultant gathers important statistics and displays them in one place, making this
information easy to understand.

The Workspace
Application List Box

Contains a list of four icons, each representing a component of your computer�s system:
Processor, Drives, Memory, and Environment. Click on one of the icons to view specific
information.

Tab Dialog Boxes
The upper list box is labeled System Info and contains details about the topic selected in
the Application List Box (see list below).

Processor
� Type of CPU (80286, 80386, 80486, etc.)
� Math co-processor present, detected or undetected
Drives
� Names of local, non-removable hard drive partitions
� Total size of each drive
� Amount of free space on each drive
Memory
� Amount of available memory in kilobytes (1024 bytes in a kilobyte)
� Percentage of free system space
� Percentage of available user space
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Environment
� Windows directory path
� Temporary directory path
� Version of Windows
� Version of DOS

Help and Tips can be accessed in the lower tab box.

Function Buttons
Close
Exit the System Consultant utility and return to the main screen.
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